Chapter 821

Reference Intervals for Clinical and Lab Medicine

Introduction

This routine calculates the sample size needed to obtain a specified relative width of a confidence interval about the limits of a reference interval calculated with a covariate (such as age).

Consider a measurement made on a population of individuals (usually healthy patients). A reference interval (RI) of this measurement gives the boundaries between which a typical measurement is expected to fall. When a measurement occurs that is outside these reference interval boundaries, there is cause for concern. That is, the measurement is unusually high or low. The reference interval is often presented as percentiles of a reference population, such as the 2.5th percentile and the 97.5th percentile. Of course, the choice of the reference population is important and you would expect that there is often differences according to age, size, and so on. In the discussion to follow, we will assume age is the covariate, but the methodology works for any continuous covariate.

This procedure calculates sample sizes for an age-specific reference interval for cross-sectional studies using the methodology given in Bellera and Hanley (2007). They provide sample size results for the reference interval methodology of Altman (1993), Royston and Wright (1998), and Royston and Sauerbrei (2008).

This methodology gives results that are similar to those obtained by quantile regression.

Technical Details

Background

There are many methods that have been proposed for estimating reference intervals (RIs). The article by Bellera and Hanley (2007) provides a method for computing necessary sample sizes for a specific method developed in a series of articles by Altman and Royston. This section will describe this method.

Data Collection

Data should be collected specifically to calculate an RI, with only one measurement per subject. The subjects selected should form a representative group without prior selection to avoid biasing the results. It is desirable to have approximately equal numbers of individuals at each age.
Models of the Mean and Standard Deviation (SD)

The fundamental assumption of this method is that at each age, the measurement of interest is normally distributed with a given mean and standard deviation. Furthermore, the means and standard deviations are smooth functions across age. Various types of models are available to model the mean and SD functions, including polynomial, fractional polynomial, and ratios of polynomials.

The reference interval equation takes the form

\[ Y = M(X) + z_\alpha SD(X), \quad 0 < X < \infty \]

where \( X \) is age, \( M(X) \) is an estimate of the mean of \( Y \) at \( X \), \( SD(X) \) is an estimate of the standard deviation of \( Y \) at \( X \), and \( z_\alpha \) is the appropriate percentile of the standard normal distribution. \( M(X) \) is estimated using nonlinear least squares. \( SD(X) \) is estimated using a separate (possibly nonlinear) least squares regression in which \( Y \) is replaced by the scaled absolute residuals. The scaling of the residuals \( (Y - M(X)) \) is made by multiplying them by \( \sqrt{\pi/2} \) (which is approximately equal to 1.2533).

The Six Step Estimation Process

The following six step procedure was suggested by Altman and Chitty (1994).

Step 1 – Fit the Mean Function

The first step is to fit the mean function with a reasonable, well-fitting model. This is usually accomplished by fitting a polynomial, a fractional polynomial, or the ratio of two polynomials. Also, the possibility of transforming \( Y \) using the logarithm, square root, or some other power transformation function is considered.

During this step, various models are investigated by considering the goodness-of-fit (\( R^2 \)), the Y-X scatter plot, and the residual versus X plot.

Step 2 – Study the Residuals from the Mean Fit

During this step, the residuals (differences) between the data and the fitted line are examined more closely. Usually, the vertical spread of the residuals will change with \( X \). This will be treated in the next step. But another feature that should be considered is whether the residuals are symmetric or skewed about zero across \( X \). Skewing is not modelled during the next step, so it must be fixed here. Skewing is usually corrected by using the logarithm of \( Y \) instead of \( Y \) itself.

Step 3 – Fit a Standard Deviation Function

The next step is to estimate the SD function. This is usually accomplished by fitting a linear polynomial to the scaled absolute residuals (SAR). The scaling factor is \( \sqrt{\pi/2} \). Occasionally, a quadratic polynomial is required, but usually nothing more complicated is needed.

Step 4 – Calculate Z-Scores

The next step is to calculate a z-score for each observation. The z-score for the \( k^{th} \) observation is calculated using

\[ Z_k = \frac{Y_k - M(X_k)}{SD(X_k)} \]

Step 5 – Check the Goodness-of-Fit of the Models

The first item to consider is the value of \( R^2 \). This value should be as high as possible, although a high \( R^2 \) is not the only consideration. But it is a starting point. The plot of the fit of the mean overlaid on the X-Y plot allows you determine whether the model is appropriate.

The z-scores should also be checked to determine that they are approximately normally distributed. This can be done by looking at a normal probability plot of the z-scores and by considering the results of a normality test such as the Shapiro-Wilk test.
Step 6 – Calculate the Percentiles

The final step is to calculate the percentiles. The formula for a percentile is reference interval equation takes the form

\[ Y_{(X, \alpha)} = M(X) + z_{\alpha} SD(X) \]

Sample Size Formulas

Bellera and Hanley (2007) derive the following formula relating the sample size to the precision of a confidence interval for a reference limit (note that a reference interval is composed of a high, and a low, reference limit). The formula is

\[ n \geq \frac{z^2_{\frac{\alpha}{2}} \left( D + \frac{z^2_{\beta}}{2} \right)}{z^2_{\frac{\beta}{2}} \left( \frac{\Delta}{100} \right)^2} \]

The parameter \( p \) is the quantile of the 100\( p \)% reference limit of interest and corresponds to the standard normal deviate, \( z_p \).

The parameter \( \alpha \) gives the confidence level of the 100\( \alpha \)% confidence interval for a reference limit and corresponds to the standard normal deviate, \( z(1-\alpha)/2 \).

The parameter \( \beta \) gives the quantile of the 100\( \beta \)% reference interval and corresponds to the standard normal deviate, \( z(1-\beta)/2 \). This reference interval is constructed to include the middle 100\( \beta \)% of the population. Usually, \( \beta \) is set equal to \( \alpha \).

The parameter \( \Delta \) is the relative margin of error. It is the percentage ratio of the width of the confidence interval for the reference limit to the width of the reference limit. The value of \( \Delta \) is usually set to a small value such as 10% so that the width of the confidence interval is small compared to the width of the reference interval.

The parameter \( D \) is a constant that depends on the assumed distribution of the covariate. If the covariate is uniformly distributed, \( D \) is 4. If the covariate is normally distributed, \( D \) is 5. If the covariate is grouped into three groups (low, medium, and high), \( D \) is 5/2. The last three options work for any value of the covariate. If, however, you are only interested in the reference limit at the average value of the covariate, \( D \) is 1.

Unequal Variance

The above sample size formula assumes that the variance of the measurement is the same across all values of the covariate. This is often not the case. In fact, the method anticipates that variance will change and attempts to model the change. In this case, Bellera and Hanley on page 613 of their article advise that the above formula can still be used as a rough guide for sample size planning.

Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains most of the parameters and options that you will be concerned with.
Solve For

This option specifies the parameter to be solved for from the other parameters.

Sampling Strategy

Design Type
Specify the distribution of the covariate. Possible choices are

Uniform Distribution
The data are chosen so that the covariate follows the uniform distribution. This common design is the default.

Low Medium High Groups
The data are selected from three groups formed by dividing the covariate into three, equal-width, ranges. These groups are called Low, Medium, and High. The center value in each group is used as the covariate value in the regression.

Normal Distribution
The covariate value appears to follow a normal distribution.

Average Covariate Value
The sample size requirements are only computed for the average covariate values. Since the results are often most precise near this average, the margin of error near the extremes is usually much larger.

Reference Limit Percentile Percentage

Reference Limit Percentage
This procedure computes the sample size needed to construct a confidence interval about a reference limit with a specified about of precision (the margin of error). This option gives the percentage of the percentile value of this reference limit.

For example, the percentage of a 94% reference limit is 94.

Distance between the Percentages used for the Reference Interval

R. I. Percentage Difference
This is the difference between the two reference limit percentages that make up a reference interval.

For example, a common choice for a reference interval is 95%. This means that the 97.5th percentile and the 2.5 percentile reference limits are required. The value entered here is 97.5 - 2.5 = 95.

Relative Margin of Error – Percentage that C.I. Width is of Reference Interval Width

Percentage Margin of Error
The margin of error is the ratio of the width of the confidence interval about the reference limit of interest to the width of the reference interval.

This ratio is expressed as a percentage. That is, the actual ratio is multiplied by 100.
Percentage Confidence Level of the Confidence Interval of the Reference Limit

Confidence Level Percentage
This is the confidence level percentage of a confidence interval of the reference limit. The range is between 0 and 100.

The recommended values are 90, 95, or 99. You should select a value that expresses the needs in your study.

Sample Size

N (Sample Size)
Enter one or more values for the sample size. This is the number of individuals selected at random from the population to be in the study. For reference interval studies, authors recommend a minimum of 300, or even 500, subjects.

You can enter a single value, a list of values, or a range of values.
Example 1 – Calculating Sample Size

Suppose a study is being planned to obtain 80%, 90%, or 95% confidence interval for the 95% reference limit of blood pressure (BP) for different ages. Sample sizes are desired for relative margin of errors from 6% to 10% compared with a 95% reference interval. It is assumed that the age distribution of the sample is uniform.

The goal is to determine the necessary sample size for each value of the relative margin of error.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Reference Intervals for Clinical and Lab Medicine procedure window by expanding Regression and then clicking on Reference Intervals for Clinical and Lab Medicine. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

Option | Value
--- | ---
Design Tab | Sample Size
Solve For | Sample Size
Design Type | Uniform Distribution
Reference Limit Percentage | 95
R.I. Percentage Difference | 95
Confidence Level Percentage | 80 90 95
Percentage Margin of Error | 6 7 8 9 10

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Sample Size N</th>
<th>Margin of Error</th>
<th>Reference Limit Percentage</th>
<th>Reference Interval Percentage Width</th>
<th>Confidence Level of the C.I. of the Reference Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>636</td>
<td>6.0</td>
<td>95.0</td>
<td>95.0</td>
<td>80.0</td>
</tr>
<tr>
<td>468</td>
<td>7.0</td>
<td>95.0</td>
<td>95.0</td>
<td>80.0</td>
</tr>
<tr>
<td>358</td>
<td>8.0</td>
<td>95.0</td>
<td>95.0</td>
<td>80.0</td>
</tr>
<tr>
<td>283</td>
<td>9.0</td>
<td>95.0</td>
<td>95.0</td>
<td>80.0</td>
</tr>
<tr>
<td>229</td>
<td>10.0</td>
<td>95.0</td>
<td>95.0</td>
<td>80.0</td>
</tr>
<tr>
<td>1048</td>
<td>6.0</td>
<td>95.0</td>
<td>95.0</td>
<td>90.0</td>
</tr>
<tr>
<td>770</td>
<td>7.0</td>
<td>95.0</td>
<td>95.0</td>
<td>90.0</td>
</tr>
<tr>
<td>590</td>
<td>8.0</td>
<td>95.0</td>
<td>95.0</td>
<td>90.0</td>
</tr>
<tr>
<td>466</td>
<td>9.0</td>
<td>95.0</td>
<td>95.0</td>
<td>90.0</td>
</tr>
<tr>
<td>377</td>
<td>10.0</td>
<td>95.0</td>
<td>95.0</td>
<td>90.0</td>
</tr>
<tr>
<td>1487</td>
<td>6.0</td>
<td>95.0</td>
<td>95.0</td>
<td>95.0</td>
</tr>
<tr>
<td>1093</td>
<td>7.0</td>
<td>95.0</td>
<td>95.0</td>
<td>95.0</td>
</tr>
<tr>
<td>837</td>
<td>8.0</td>
<td>95.0</td>
<td>95.0</td>
<td>95.0</td>
</tr>
<tr>
<td>661</td>
<td>9.0</td>
<td>95.0</td>
<td>95.0</td>
<td>95.0</td>
</tr>
<tr>
<td>536</td>
<td>10.0</td>
<td>95.0</td>
<td>95.0</td>
<td>95.0</td>
</tr>
</tbody>
</table>
Report Definitions
N is the total sample size of the study.
Margin of Error: the measure of precision. It is the percentage that the width of the confidence interval of the reference limit is of the width of the reference interval.
Reference Limit Percentage: the percentage at which the reference limit is calculated. Assuming the data are normally distributed, it gives the percentage of the data values that are below the specified limit.
Reference Interval Percentage Width: the difference between the two reference interval percentile percentage values.
Confidence Level of the C.I. of the Reference Limit: the percentage of such confidence intervals that cover the true reference limit.

References

Summary Statements
A sample size of 636 produces a two-sided 80.0% confidence interval of a 95.0% reference limit that has a width that is only 6.0% of the width of a 95.0% reference interval. This calculation assumes that the distribution of the covariate is uniform and the reference limit may be computed at any covariate value.

This report shows the calculated sample size for each of the scenarios.

Plots Section

These plots show the sample size versus the margin of error (MoE) for the three confidence levels.
Example 2 – Validation using Bellera and Hanley (2007)

Bellera and Hanley (2007), page 612, give an example of a study planned to obtain 95% confidence interval for the 95% reference limit of blood pressure (BP) for different ages. They calculate the sample size for a relative margin of error of 10% compared with a 95% reference interval, assuming the age distribution is uniform. They obtain a sample size value of 536.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the **Reference Intervals for Clinical and Lab Medicine** procedure window by expanding **Regression** and then clicking on **Reference Intervals for Clinical and Lab Medicine**. You may then make the appropriate entries as listed below, or open **Example 2** by going to the **File** menu and choosing **Open Example Template**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Design Type</td>
<td>Uniform Distribution</td>
</tr>
<tr>
<td>Reference Limit Percentage</td>
<td>95</td>
</tr>
<tr>
<td>R.I. Percentage Difference</td>
<td>95</td>
</tr>
<tr>
<td>Confidence Level Percentage</td>
<td>95</td>
</tr>
<tr>
<td>Percentage Margin of Error</td>
<td>10</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th></th>
<th>Sample Size</th>
<th>Margin of Error</th>
<th>Reference Limit Percentage</th>
<th>Reference Interval Percentage Width</th>
<th>Confidence Level of the C.I. of the Reference Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>N</td>
<td>536</td>
<td>10.0</td>
<td>95.0</td>
<td>95.0</td>
<td>95.0</td>
</tr>
</tbody>
</table>

PASS also calculates the sample size to be 536.